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1. GC1115 Daughtercard and GC101 EVM Setup 
 
The software should be installed before connecting the boards to the computer. 
GCStudio_Setup.exe should have been provided either through the web, or on a CD with this 
package. Double-click on the icon for the GCStudio_Setup.exe program. This will launch an 
Installshield wizard. All of the defaults in this wizard should be sufficient for most users. 
 
The GC1115 daughtercard combined with the GC101 motherboard provide a hardware 
evaluation platform for development of application specific settings for the GC1115.   To operate 
the system, simply plug the GC1115 daughtercard into the DIMM socket on the GC101 
motherboard, connect the parallel port interface cable to the GC101 and Host Computer (PC), 
and connect the power supply to the GC101. 
 
Texas Instruments can provide users with a direct interface between the GC101 and our high 
performance DACs including the DAC5687. For users that wish to measure analog performance 
from the GC1115 + GC101, please contact your local sales representative for hardware and 
software installation materials.   
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2. An Introductory Example 
 
Let's get started. This example will walk you through opening an existing GC Studio project that 
configures a single channel multi-carrier input signal with 6dB target PAR through CFR using 
complex parallel input and output modes. 
 
 
2.1 Running a Factory GC-Studio Project 
 
First, open the GC-Studio program from the Start menu. 
 

 
 

Figure 2-1. GC Studio Program Start Menu. 
 

The main GC-Studio screen will be presented to you. 
 

 
Figure 2-2. GC-Studio Program Main Screen. 
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Select "Open Project" from the File Menu, to be presented with a dialog that will allow you to 
select where the factory project is located. Select GC1115 from the “My GC Studio Projects” 
directory. Now select the “UMTS_4Carrier_6dB_16x” directory, the following window will be 
presented.  
 

 
Figure 2-3. Project Selection Window. 

 
The “_digital” implies the project does not require any external clock solution; as such, all that is 
required to run this experiment are the materials provided with the GC1115 System Evaluation Kit 
(SEK), which includes a GC101 motherboard and GC1115 daughtercard. The experiment should 
be ready to run; click the Build button, as indicated below, to execute the experiment. 
 

 
Figure 2-4. GC-Studio Control Panel. 

 
 

If the GC101 motherboard is operating correctly and the configuration of the experiment is 
complete, the D2 LED will turn ON. 
 

 
Figure 2-5. Configuration Complete Indication. 

 
Although the target PAR is 6dB, the experiment should reduce the PAR of a 4 carrier UMTS 
(TM3_16x) signal from approximately 13dB down to 6.6dB. The process by which the PAR is 
reduced is explained in the datasheet, the information also relates why target and output PAR are 
not equal. The spectral performance of the device with the factory settings is exceptional with 
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over 70dBc of ACLR. The results are illustrated in Figures 2-6 and 2-7, the default results for all 
experiments included with the software, including the time measurements, are also provided in 
the project directory as “Project Name_Description_digital.bmp.” In the figure, the x-axis 
corresponds to the PAR level in dB while the y-axis corresponds to the number of samples y, in 
the expression 10y. In the example below, the input PAR at 10-4 samples (or 10-2%) is 13dB. The 
CCDF plot also indicates a power difference between the input and output data, it is up to the 
user to adjust the digital output gain of the GC1115 once proper system margins are determined. 
 

 
Figure 2-6. CCDF Performance of Input and Output Data.  

 

 
Figure 2-7. Spectral Performance of Input and Output Data.  
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2.2 GC-Studio Performance Metrics 
 
In Figure 3-6 of the previous section, there are additional “Performance Metrics” included in the 
default program. These metrics indicate the “Maximum Real Time Value” of the input and output 
ports. When CFR is applied to a signal the peak levels are reduced; as such, some gain is 
required at the output of the GC1115 to fully use the dynamic range of the data converter. To 
determine the above mentioned levels, first click on the “Add New Performance Metric” button to 
open the window illustrated in Figure 2-8. 
 

 
Figure 2-8. GC-Studio Performance Metrics Setup Wizard.  

 
Select “Maximum Real Time” from the selection menu and click “Next”. You are asked to select a 
source for the input, choose “Input Port A”. Repeat the steps above and select “Output Port A” as 
a the second source; the “Performance Metrics” window should now appear similar to that shown 
in Figure 2-9.  

 
Figure 2-9. Performance Metrics Window.  

 
The GC1115 data sheet describes that registers 0xF3 and 0xF4 are used to control the output 
gain, for this example the Out_Gain values are set to 17800 as calculated by the equation 
described below with some additional margin. It is however, up to the user to modify these 
registers to ensure proper operation of the DAC with appropriate margins. 
 
   Max Real Time Value (Input Port A)   *  2^13  =  Out_Gain +/- 5% Margin 
 Max Real Time Value (Output Port A) 
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To modify these registers, double-click on the GC1115 block diagram in GC-Studio, then click on 
the “Soft Limiter” block within the diagram window. The values of output gain registers are defined 
by the variables “Out_Gain0” and “Out_Gain1,” as indicated in Figure 2-10.  
   

 
Figure 2-10. Soft Limiter Gain Settings.  

 
As with all other registers in the GC1115, the user may program these individually by clicking into 
the hierarchy of the device through GC-Studio. Some registers, after being modified by the 
user, may no longer be controllable through the CMD1115 interface. Some additional 
features of this interface are described in Sections 3 and 4. After modifying the gain values and 
executing the experiment once again, the plot windows for CCDF and spectral performance 
should be updated to reflect the gain change. These are attached below as Figures 2-11 and 2-
12. 
 
.  
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Figure 2-11. CCDF Performance of Input and Output Data with Gain Optimization.  

 

 
Figure 2-12. Spectral Performance of Input and Output Data with Gain Optimization.  
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Another performance metric when evaluating the GC1115 device is error vector magnitude 
(EVM), this is a measure of the constellation error. This metric gives the user the ability to 
determine the effects of CFR on the input signal EVM. Typical EVM measurements are made 
using software or hardware capable of demodulating both the input and output signals. This 
particular performance metric is only used as a figure-of-merit to optimize the device performance 
prior to actual in-system evaluations.  
NOTE: One consideration prior to attempting this measurement is that the input and 
output capture buffers must be identical in length.   

 
To make an EVM measurement, click the “Add New Performance Metric” button and select the 
“General Error Vector Magnitude” measurement from the menu and click “Next”, the 3GPP EVM 
measurement does not apply to the validation of the GC1115. The user is then asked to select a 
data source as a reference for the calculation, select the “Input Port A” source and click “Next”. 
The user is then prompted to enter the second argument for the function calculation, in this case 
“Output Port A” and click “Finish”. The general EVM is now included in the “Performance Metrics” 
window and should display a value of 16.67% as indicated in Figure 2-13. 
   

 
Figure 2-13. Performance Metrics Window Including EVM.  

 
 
NOTE: This is only a reference measurement; the result should not be interpreted for final 
system validation. 
 
 
 
. 
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2.3 Running a Factory GC-Studio Project with a DAC5687 
 
It is often necessary to observe the output of the GC1115 CFR processor through a spectrum 
analyser. TI provides state-of-the-art D/A devices; the DAC5687 evaluation module gives the user 
the potential to measure the performance of the GC1115 through test & measurement equipment, 
often a spectrum analyser. These can be equipped with software packages that allow 
measurement of peak code domain error (PCDE) and error vector magnitude (EVM). These 
measurements are required when trying to maintain performance within operational standards 
and regulations. The most significant difference in configuring the GC101 with a DAC5687 EVM 
is that the GC101, through the GC-Studio software, is now configured to accept an external clock. 
As such, a clock source must be provided by the user, the connection and setup of this source is 
detailed in this section.   
 
The following section describes a second UMTS experiment that now includes a DAC5687 EVM 
attached to the GC101 through an interface card.  
 
Required Elements before Installation: 

• DAC5687 evaluation module. 
• Power supply with dual controllable outputs (3.3V and 1.8V). 
• Interface card to connect the GC101 motherboard to the DAC5687 module (provided with 

the GC1115 SEK). 
• Controllable local oscillator (LO) source capable of generating frequencies up to 500MHz 

at a 4dBm output power. 
• Spectrum analyser or other test & measurement equipment. 
• SMA cables and other miscellaneous connectors. 

 
2.3.1 GC101, GC1115 and DAC5687 Hardware Connections 
 

1) With all power sources turned OFF, connect the headers on the right-side of the GC101 
motherboard, through the provided interface card, to the headers on the left-side of the 
DAC5687 evaluation module. The interface card and connections are illustrated in Figure 
2-14. 

 
Figure 2-14. GC101, GC1115 Daughtercard, Interface Card and DAC5687 EVM. 

 

3.3V

1.8V
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2) Connect the GC101 J1 “EXTCLK IN” connector to the DAC5687 J2 “PLL LOCK” 
connector using a typical SMA cable (BLUE arrows). 

 
3) Connect the external LO source to the J4 “CLK2” connector, set the frequency to 

491.52MHz, and the LO power level to 7dBm (GREEN arrow). 
 
4) Connect the 3.3V power source to the right-most banana connectors and the 1.8V power 

source to the left-most banana connectors. 
 

5) Connect either the “IOUTA” and/or the “IOUTB” SMA connector to the test & 
measurement equipment (RED arrows).    

 
6) Turn ON the two power sources to the DAC5687 and connect power to the GC101 

motherboard.  
Notes: 3.3V uses ~130mA and 1.8V uses ~412mA at start-up. 
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 2.3.2  GC-Studio and DAC5687 Software Configuration 
 
The following figure illustrates the register settings for the DAC5687 EVM operating with 8x 
interpolation. For DAC5687 software installation, please refer to online instructions or the users 
guide supplied with the hardware. The default DAC register settings are also stored in the project 
directory as: “dac_registers.reg5687“. These register settings behave correctly for an experiment 
with the gain optimization explained in Section 2.2, they can also be used for general testing. 
 

 
Figure 2-15. DAC5687 EVM Configuration with 8x Interpolation. 

 
Select "Open Project" from the File Menu, to be presented with a dialog that will allow you to 
select where the factory project is located. Select GC1115 from the “My GC Studio Projects” 
directory. Now select the “UMTS_4Carrier_6dB_16x” directory, the following window will be 
presented.  
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Figure 2-16. Project Selection Window. 

 
The “_DAC” implies the project requires an external clock source that is provided, in this case, by 
the DAC5687 evaluation module. The experiment should be ready to run; click the Build button, 
as previously indicated in Figure 2-4. The digital outputs plots should appear identical to those 
that resulted from the digital experiment. 
 
The DAC5687 is a dual channel data converter, with the register setting adjusted to the values 
indicated in Figure 2-15, the four carrier signal should be centered at 153.6 MHz. The peak to 
average reduction can be observed using the signal statistics analysis menu from the test 
equipment. The output CCDF indicates a PAR (Crest) of ~6.7dB after processing through the 
GC1115, the typical difference between the digital and analog measured results can be attributed 
to the regrowth that occurs in the digital-to-analog conversion process; the outputs are shown in 
Figures 2-17, 2-18 and 2-19; these results indicate the input, output and gain adjusted output 
signal. The spectral performance of the I-output is measured using a R&S FSQ-8 spectrum 
analyzer and the results are attached in Figures 2-20, 2-21 and 2-22. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 16

 
Figure 2-17. Measured Peak-to-Average Ratio without CFR. 

 

 
Figure 2-18. Measured Peak-to-Average Ratio after CFR without Gain Optimization. 

 

 
Figure 2-19. Measured Peak-to-Average Ratio after CFR with Gain Optimization. 
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Figure 2-20. Measured Spectral Performance without CFR. 

 

 
Figure 2-21. Measured Spectral Performance after CFR without Gain Optimization. 

 

 
Figure 2-22. Measured Spectral Performance after CFR with Gain Optimization.  
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3. Creating a New GC Studio Project 
 
Select “New Project…” from the File Menu, to be presented with a dialog that allows the user to 
select where the new project is saved. The program does not assign a device-specific directory; it 
is recommended that the user select a sub-directory that corresponds to device under test (DUT), 
in this case the GC1115 directory. Let’s call this project “UMTS_2Carrier_6db_asym” and click 
“Create” as shown in Figure 3-1. 
 

 
Figure 3-1. Project Location and Name Window. 

 
The next screen allows us to select the plug-in to use for this project. Select the GC1115 plug-in 
and click OK to be presented with the wizard that will setup the basics of this project.  
 

 
Figure 3-2. DUT Selection Window. 

 
Click “Next” on the following screen to be presented with the “Evaluation Board Setup” window, 
this window has three selection tabs: Stimulus Memory, Response Memory, and Clock and Sync. 
From the “Stimulus Memory” tab, change the “Memory Length” to 614400, which corresponds to 
a 10ms sequence at 61.44 MSPS. Select the “Response Memory” tab and change the “Memory 
Length” to 614400. The default settings in the “Clock And Sync” tab should be correct for a digital 
simulation. Please refer to Appendix A of this Users Guide for a comprehensive explanation of 
“Skew Bank” and clock settings, these parameters will require frequency specific settings that 
must be adjusted for proper operation of the GC1115 and GC101. Click “Next”, you are now 
presented with the “General GC1115 Settings” window.  
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The parameters in this window can be categorized into 4 groups, cancellation calculation 
parameters, detection calculation parameters, IO process parameters and TDD parameters, 
these are listed below: 
1. Detection Calculation Parameters 
Target PAR relative to input:  Sets the Target par level. It is used to calculate the detection and  
   gain thresholds for peak cancellation 
 
2. Cancellation Calculation Parameters  
Sampling Frequency:  CFR sampling frequency, GC1115 input clock rate. 
RRC Filter: 
   -RRC Alpha:   This parameter is the RRC alpha parameter. 
   -Samples/Symbol:  This is the DUC interpolation ratio for RRC filter design. 
Firls Filter: 
   -PassBand Freq:  This defines the cancellation filter bandwidth or passband. 
   -StopBand Freq:   This sets the stopband frequency of the filter. 
   -StopBand Weight Factor: Defines the amount of emphasis to put on minimizing the   
   integral squared error in each band relative to the other bands. 
  
Kaiser-Bessel Alpha:  After the RRC filter is designed, the program applies a Kaiser-  
   Bessel window to it to obtain optimum ACLR. This is the Window  
   alpha parameter. 
Carrier Frequencies:  Specify each carrier’s center frequency for proper cancellation pulse  
   allocation. 
# Coefficients:   Set the number of coefficients (taps) for the filter 
BandPass (Match): For symmetrical multi-carrier systems, makes optimal use of cancellation 
   coefficients when set to 0. See Table 1 for typical settings with Match=0. 
 

Table 1. WCDMA cases with Fs=61.44MSPS. 
# of Carriers Roll-Off` Samples/Symbol 

1 
2 
3 
4 

0.18 
0.18 
0.18 
0.18 

16 
8 

5.5-6 
4 

 
3. IO process parameters 
Input Port X:   Sets the input file location. 
Number of Channels:  Sets the number of CFR channels 
Input Format:   Select either binary or 2s compliment for input data 
Input Mode:   Set the input data mode. 
Output Format:  Select either binary or 2s compliment for output data 
Output Mode:   Set the output data mode. 
Input Decimation:  Set the decimation ratio at the GC1115 input 
Interpolation mode:  Set the interpolation ratio in the interpolation block. 

 
4. TDD Parameters 
TDD 0 Detection Cnt: Number of consecutive points detected below the TDD Threshold  
   Magnitude that are to be omitted from PAR calculations (Section 5.1). 
TDD Threshold Magnitude:  This threshold defines the magnitude of the signal when it is to be  
   removed from PAR calculations (Section 5.1). 
 
The default settings for the “Target PAR”, “Sampling Frequency”, filter parameters, etc. are 
correct for this example; all of these settings are explained in the data sheet. In the “Input Port A” 
box, click on the ‘…’ button and choose the “TM1_16x_2FA_2C.gcin” file from the “..\My GC 
Studio Projects\GC1115\” directory, this file was generated by Agilent ADS software. The test 
signal is an asymmetric; as such, the carrier locations must be specified to be 2.5MHz and -
7.5MHz, this is illustrated in Figure 3-3.   
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Figure 3-3. General GC1115 Settings Window. 

 
Click “Next” to continue setting up the experiment. Normally this will take 1-2 seconds before the 
following window shows up. The program is loading the input data and the delay is dependent on 
the input data size. Based on the variables that were defined in the “General GC1115 Settings” 
window, the program will calculate cancellation coefficients, detection and gain threshold, I/O 
register values, etc. Most of the common settings for the GC1115 can be controlled from this 
window, thus allowing the user to create projects from a higher abstraction level. 
   
The following screen invites the user to include a “Project Description.” For this project, a 
suggested project description is shown below: 
  

UMTS 2 Carrier 16x CFR with one gap and an asymmetric configuration. 
 
This project shows the effect of CFR on a UMTS two carrier signal.  The net effect is that 
the CCDF Plots Graph shows that the output has been limited to basically a 6dB PAR. 
This type of experiment is the most stringent on GC1115 ACLR performance. 
 

The final screen shows that the GC1115 experiment has been created. Click Finish to go to the 
GC1115 block diagram. 
Double-clicking on the large “GC1115” block will zoom into another level of abstraction in the 
device, presenting the main block diagram for the GC1115. The project can be executed as was 
previously illustrated in Figure 2-4. The “Status” window at the bottom portion of GC-Studio 
indicates the progress of the experiment, as shown in Figure 3-4. When the “Capture loop has 
terminated” statement appears, data is ready for plotting and analysis.  
 

 
Figure 3-4. GC-Studio Status Window. 
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3.1 Using GC-Studio for Data Plotting and Analysis 
 
This plotting tutorial quickly shows the user how to do spectral and CCDF plots using input and 
output data from the GC1115. The data collected during the previous experiment is used for the 
plotting examples described in this section. The ability to export output data is also explained in 
this section. 
 
3.1.1 GC1115 Spectral Performance   
 
To create a plot using GC-Studio first click on the “New Graph” button illustrated in Figure 4-5.  
 

 
Figure 3-5. GC-Studio Control Panel. 

 
A new “GC Studio Graph” window will open. From the “Plot Type”, select “Spectral Magnitude” as 
shown in Figure 3-6 and check the “Logarithmic” box. Click the “Add New Data Source” button, 
this will allow the user to select the source waveform that is to be analyzed. First, select “Input 
Port A” and click “OK”; the spectrum of the input data is now added to the graphing window. Click 
on the “Add New Data Source” button a second time to add the “Output Port A” waveform to the 
existing plot. The previous steps are illustrated in Figure 3-7.  
 

 
Figure 3-6. GC-Studio Graph Type Selection. 

 

   
Figure 3-7. GC-Studio Graph and Source Selection Controls. 
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3.1.2 GC1115 CCDF Performance   
 
To create a second plot using GC-Studio first click on the “New Graph” button as explained in 
Section 3.2.1. A new “GC Studio Graph” window will open. From the “Plot Type”, select “CCDF” 
as shown in Figure 3-8. Select the Input and Output data sets using the “Add New Data Source” 
button, described in the previous section.  
 

 
Figure 3-8. GC-Studio Graph Type Selection. 

 
The graphed results from the previous two sections are attached below in Figure 3-9; for more 
graphing options please consult the GC-Studio Users Guide. 
 

 
Figure 3-9. GC-Studio Spectral and CCDF Graph of Results. 
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3.1.3 Exporting Output Data for Post-Processing   
 

It may be desirable to store the output file from the GC1115 for post-processing and signal 
analysis. GC-Studio allows the user to output complex data in two-column format. To setup an 
output file, simply double-click on the GC1115 block diagram in GC-Studio to see the next level of 
hierarchy of the device. Then select the green file to the right of the diagram as illustrated in 
Figure 3-10. The “Output Port A” options will then be listed in the right pane of GC-Studio.     

 

 
Figure 3-10. GC-Studio Output File Control. 

 
Now select the “Save To File” option, the user must now enter a file location and name to collect 
the output data; this is shown in Figure 3-11. The standard text-format data is updated every time 
the experiment is executed with a default “.gcout” extension, the new data will overwrite the old.  
   

 
Figure 3-11. GC-Studio Output File Specification. 
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4. Using GC-Studio with TDD Data (WiMAX) 
 
With the growing popularity of time-division duplexing (TDD) standards such as TD-SCDMA, 
WiMAX and WiBRO, Tx/Rx sensitive software tools are required. In this section, we will 
demonstrate a simple WiMAX experiment and will show the user how to use the new TDD tools.   
First, open the default WiMAX project from the GC1115 directory using the instructions provided 
in Section 2.1; the project name is “WiMax_1Carrier_8dB_10x_digital.gcproj.” This project 
reduces the PAR of a single 10MHz WiMAX carrier down to 8dB; the system design constraints 
for WiMAX are such that the 8dB target is reasonable while maintaining EVM specifications. 
Figure 4-1 indicates the default settings for the factory WiMAX project.  
 

 
Figure 4-1. General GC1115 Settings 

 
 
For TDD type data, the PAR of the complete signal, will be greater than if only the Tx (downlink) 
is considered. The Rx (uplink) segment of the signal does not contain any data and should be 
removed from calculations. The CMD1115 window sets the PDC gain and detection thresholds 
based on the value entered in “Target PAR relative to input”. For the case illustrated in Figure 4-
1, all 10 consecutive values <= 7000 are ignored from calculations where 7000 corresponds to 
the threshold defined by: real2 + imaginary2. The TDD parameters should not affect typical 3GPP 
modulation schemes as these use individual Tx/Rx frequency allocations.   
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4.1 Using the Stream Cropping Tool (WiMAX) 
 
The WiMAX experiment is fully loaded and ready to run, execute the experiment as was 
demonstrated in Section 2.1. The following plot should be available at the completion of the 
experiment, this figure illustrates the timed input and output data. 
 

 
Figure 4-2. GC1115 Input and Output Time Data 

 
The CCDF is also shown below as Figure 4-3, it appears from this figure that the input PAR is 
12.3dB while the output PAR is approximately 9.8dB. These numbers do not account for the 
uplink data, it can be observed from Figure 4-2 that approximately half of the data points should 
be removed from our analysis. Therefore the average of the signal is likely off by nearly half or 
3dB. To see this effect, we now present the “Stream Cropping Tool” to give more accurate 
feedback when looking at TDD data.    
 

 
Figure 4-3. CCDF of Input and Output Data without Cropping 
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First, we must open the “Stream Cropping Tool” from the “Tools” pull-down menu, as indicated in 
Figure 4-4. 
 

 
Figure 4-4. Stream Cropping Tool from the GC-Studio Control Panel.  

 
Place the mouse pointer over the “Input Port A” data set and select the entire downlink data set. 
You must click-and-hold at one end of the data set, and then drag the pointer across the window 
to highlight the entirety of the desired signal, as shown in Figure 4-5. Once you release the 
mouse button, the window should zoom in on the selected data. Click once on the “Crop To 
Zoom” button, the tool should now only include the data that was previously selected. Change the 
“Stream” from “Input Port A” to “Output Port A” and repeat the steps above to zoom in on the 
correct data, as shown in Figures 4-5 and 4-6.     

 

 
Figure 4-5. Using the Stream Cropping Tool to Select the Data.  

 

 
Figure 4-6. Output Port A and the Stream Cropping Tool.  
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Now close the “Stream Cropping Tool” window and re-open the previous CCDF plot. The new 
plot should clearly reflect the removal of the Rx (uplink data) from the CCDF calculations; this plot 
is shown in Figure 4-7. The input and output data now show a PAR of 10.5dB and 8dB, 
respectively.   
 

 
Figure 4-7. CCDF of Input and Output Data with Cropping. 

 
The spectral performance of the cropped input and output data are also included in Figure 4-8. 
   

 
Figure 4-8. Spectral Performance of Input and Output Data with Cropping. 

 
To undo the effects of the “Stream Cropping Tool”, open the tool again from the “Tools” pull-down 
and select the “Uncrop All” button.   
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4.2 WiMAX Experiment with DAC5687 and VSA89600 
Demodulation  

 
For this experiment, the DAC5687 is configured in 4x interpolation mode. The register settings for 
the DAC are stored in the “..\WiMax_1Carrier_8dB_10x” project directory as “wimax.reg5687”. 
Select "Open Project" from the File Menu, to be presented with a dialog that will allow you to 
select where the factory project is located. Select GC1115 from the “My GC Studio Projects” 
directory. Now select the “WiMax_1Carrier_8dB_10x” directory, from this directory select and 
load the “WiMax_1Carrier_8dB_10x_DAC.gcproj” project.  
 
When the project is executed the screenshot shown in Figure 4-9 should be observed from 
Agilent’s VSA89600 demodulation software tool. The figure shows the PAR of the signal is 
reduced to 8dB and the EVM is 1.35%, the EVM performance can be improved through further 
degradation of the spectral performance. The user is encouraged to experiment with the 
cancellation parameters to maximize PAR reduction while maintaining system requirements. 
  

 
Figure 4-9. WiMax Signal at DAC5687 Output with VSA89600 Demodulation Software. 

 
The user has the ability to turn off the cancellation in real-time to see the effects of CFR on the 
signal integrity. First, from the “Tools” pull-down menu of the GC-Studio Control Panel, select the 
“Script Editor”, as shown in Figure 4-10. 
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Figure 4-10. Script Editor Tool from the GC-Studio Control Panel. 

 
The script editor allows the user to directly “ping” register values from the GC1115. The user may 
read or write a value to a specific register. To write to a register, the command is simply 
WriteDevice(register, value), where register and value are in decimal format. The 
ReadDevice(Register) command allows the user to read a register value from the device. For this 
experiment, register 0x3 controls the peak detection and cancellation stages; the command 
“WriteDevice(3,16)” will write the hexadecimal value of 0x10 to the register. Type in this 
command and click “Run!” to execute the command. From the data sheet, the user can observe 
that this register write will by-pass the PDC stages however, the interpolation remains ON. 
Interpolation is required to maintain the correct data rates. Figure 4-11 illustrates the WiMax 
signal performance with the GC1115 in a by-pass mode, the figure shows an input PAR of 9.2dB 
at 10-2% and an EVM of 0.32%.  
  

 
Figure 4-11. WiMax Signal at DAC5687 Output with VSA89600 Demodulation Software 

(GC1115 in by-pass mode). 
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Appendix A- Frequency Dependant Skew Adjustments 
 
As with most typical digital devices, the data stream between devices must be properly timed. 
This is typically done by adjusting the clock/signal skew between devices. In this case, the timing 
between the GC101 to GC1115 and GC1115 back to the GC101 must be adjusted. This section 
describes typical skew settings based on the clock rate of the experiment for GC101 and GC1115 
operating with the DAC5687 EVM. The most common symptom of bad or inaccurate skew setting 
is unexpected spectral regrowth either at the GC1115 output or looking at the DAC output with a 
spectrum analyzer. 
 

 Table 2. Frequency Dependant Skew Adjustment Values. 
Clock 

Frequency 
GC101+GC1115 w/ 

On-Board Reference 
GC101+GC1115 w/ 

DAC5687 EVM 
60MHz 4,4,2,2 / (4)3,4,4,4 4,4,2,2 / (4)3,4,4,4 

80MHz 4,4,2,2 / 4,4,4,4 4,4,2,2 / 4,4,4,4 

100MHz 3,4,4,4 / 3,4,4,4 3,4,4,4 / 3,4,4,4 

120MHz 3,4,4,4 / 3,4,4,4 3,4,4,4 / 3,4,4,4 

   
 




